
Ringtail Basics 
Quick Start Guide
Ringtail 9 brings a new level of simplicity, ease of use, 
and efficiency to document review. The following pages 
walk through scenarios, based on common tasks, to 
show the Ringtail features that make the interface easier 
to use and that add speed and accuracy to review tasks.
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Follow the Ringtail link and log in to Ringtail.

Note: Your user name is not case-sensitive. Your password 
is case-sensitive and must adhere to the password 
parameters for your organization.

If you are logging in for the first time, you will be prompted 
to accept the End User License Agreement.

On the Portal Home page, click the link for a case.

Log in and select a case

Log
in

and
selecta

case

Tip: You can pin frequently accessed cases to the 
top of the list.

Note: Your administrator must enable and configure some features.



View updates and notifications

U
pdates

and
notifications

Click the Notifications bell on the toolbar on the Portal Home page to see notifications from your 
administrator.

Note: Your administrator must enable and configure some features.

A “What’s new in Ringtail” box 
is available on the Portal 
Home and Case Home pages. 
Follow the link in this box to 
read about recent changes to 
Ringtail.

On the release notes page, 
you can view release notes for 
On-Premise environments and 
SaaS/Hosted environments.
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Navigate the interface - Case Home page

On the Case Home page, the Case Site Map allows you to access key features in Ringtail quickly.

 Group 
member 
(sample view)

Group leader 
(sample view) 

Note: Your administrator must enable and configure some features.
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Navigate the interface - Case Home page
My Assignments and Review Dashboard

Users with permissions can access the following pages from the navigation pane on the Case Home page:

My Assignments

Review Dashboard

Note: Your administrator must enable and configure some features.
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Navigate the interface - Case Home page
Concept Cloud

The Concept Cloud displays a word cloud of the concepts that were found in a specific document set. The 
larger the word, the more common the concept is. You can display concepts for all documents in the case, or 
for documents in a binder, issue, population, sample, or workflow or phase. Use the slider to hide common 
concepts and display less common concepts.

To view documents that contain a concept, click a word in the Concept Cloud. For example, if you click the 
word “commission” in the Concept Cloud, Ringtail performs a search and displays your results on the 
Documents page.

Note: Your administrator must enable and configure some features.



Case Home page – User interface elements
The Case Home page includes some or all of the following items:

Navigation bar: This bar at the top includes the following items (from left to right):
• Ringtail logo: Click the Ringtail logo to navigate to the Portal Home page from any page in the case. You can open 

a different case from the Portal Home page.
• Case name: Click the case name to return to the Case Home page from any page in the case.
• Case Home menu: Use this menu to access different areas of Ringtail, such as the Documents page or the Review 

Setup page. The Case Home menu and Documents option always appear. The Transcripts option appears if you have 
permission to access transcripts that are loaded in the case, and the remaining menu options appear if you have 
permission to access the associated pages.

• Quick search box: The quick search box always appears.
• Quick search menu: Use this menu to change the quick search options. The options that appear on this menu 

depend on your permissions.
• Group name and menu: If you belong to multiple groups, you can switch between groups that are listed on the 

menu.
• User name and menu: Hover over your user name to view details. To log out of Ringtail, click Log out on the menu. 

You can also click the user name menu to set search preferences, reset your workspace to the default settings, or 
access bookmarks.

Toolbar: This bar includes the following items:
• Breadcrumb and breadcrumb menu: Breadcrumbs allow you to track and navigate back to Ringtail pages. Click 

the arrow next to the Home button to open the breadcrumb menu, which displays the same list of Ringtail pages as 
the Case Home menu.

• Browse: Click this button to open the Documents page with a workspace that contains the Browse pane.
• Search: Click this button to create a new advanced search on the Search page. 
Case Site Map: Allows you to access key features more quickly, such as assignments or cubes. You can also access your 
results history and document history. If enabled, this page also includes a “What’s new in Ringtail” section. Follow the 
link to read about the latest Ringtail features.
Information bar: The information bar at the bottom of every page contains a button to open the online help, as well 
as copyright and version information.

N
avigate

the
interface

Note: Your administrator must enable and configure some features.



Navigate the interface – Documents page overview
On the Documents page, you can browse, find, review, and code documents. 

To access the Documents page, if you have already returned a results set, on the Case Home page > Case 
Site Map, click a link under Results History or Document History.

N
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Note: If you have not previously 
returned search results, click the Search
button on the Case Home page. After 
you run a search, a link to your search 
appears on the Case Site Map.

Ringtail displays the Documents page with the default workspace.

Note: Your administrator must enable and configure some features.



Documents page – User interface elements
The Documents page includes some or all of the following items on the toolbar (from left to right):

N
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Note: Your administrator must enable and configure some features.

• Search results arrows: Use the arrows on the left to quickly browse through search results.
• Search description: Click the description of the search results to open the search.
• Document information: This information appears below the search results arrows and can include the 

following information:
• Search preferences indicator: a threaded icon appears if Threading was enabled for the search, a 

paper clip icon appears if Sources and attachments was enabled, and a rendition icon appears if 
Renditions was enabled.

• A button that allows you to copy the active Document ID to the clipboard.
• The active Document ID.
• Total document count.
• Selected document count. Click the X to quickly unselect these documents.

• Browse: Click the Browse button to open the Browse pane, if it is not already open.
• Search: Click the Search button to create a new advanced search.
• Workspaces buttons and menu: To change the current workspace configuration, click a different 

workspace button. To open a menu that allows you to add a new workspace, modify an existing 
workspace, or select workspaces to pin to the toolbar, click the arrow next to the workspaces button.

• Tools: To use document tools, click the arrow next to the Tools button.
• Document arrows: Use the arrows on the right to quickly browse through documents in the results set.

Tip: To increase the height of your workspace, you can collapse the Documents page toolbar. Click the 
Collapse button on the navigation bar, next to your user name.



You can set preferences for searches, including whether to include threaded documents, attachments with 
source documents, or renditions in your searches. You can also include line numbers in your search results 
in the List. All options are cleared by default.

The Search preferences menu option is available on the user name menu on the navigation bar of any page 
in the case.

Once saved, Ringtail applies your preferences to your next search and to subsequent searches.

Note: The options that you set on the Search preferences menu sync with the search preference options at 
the bottom of the Search page.

Set search preferences

Search

Note: Your administrator must enable and configure some features.



Use the quick search box, which is available on 
the navigation bar of all pages in the case, to 
perform simple searches. 

Simply start typing in the quick search box to 
start your search. In the results list, you can 
filter by certain search parameters.

If you have permission, you can also manage 
the properties or security for objects such as 
binders.

The quick search menu, available by 
clicking the gear button next to the quick 
search box, lists the types of searches that 
you can perform.

Note: Only one option, Document
Content, is selected by default.

Run a simple search

Search

Note: Your administrator must enable and configure some features.



To access the Search page, click the Search button on the Case Home page or the Documents page.
• Select from a wide range of fields, operators, and values.
• To set search preferences, select the check boxes at the bottom of the page. All options are cleared by 

default. 
• To run the search, click Search. 

Perform an advanced search

• To create a new search, click the Search button on the toolbar.
• To use the previous search criteria in a new search, click the search results name 

on the toolbar.

Use the Search
menu to create a 
new search, or to 
copy, open, save, or 
delete a search. You 
can pin these 
options to the 
Search toolbar.

Note: If you 
attempt to save an 
existing saved 
search, a 
confirmation 
message appears 
and you must click 
OK to confirm 
overwriting the 
existing saved 
search.

Search

Note: Your administrator must enable and configure some features.



Add new clause

Add additional criteria (Coded by)

Remove additional criteria

Delete clause

Create group

Remove from or delete group

View selection (for example, mines and cubes)

Run only this line of the search query

Build your search using the values, operators, and buttons on the Search page.

Build a search query

Tip: To build your 
search without 
using a mouse, 
click the Keyboard 
Shortcuts button 
on the toolbar or 
the Search menu 
to see a list of 
keyboard 
shortcuts.

Search

Gray bracket: Group of search queries.
Green bracket: Group of search queries joined by an “or” 
operator.
Red bracket: Group of search queries joined by an “and” 
operator.
Blue bracket: Group of search queries joined by a “not” 
operator.

Note: Your administrator must enable and configure some features.



To open the Browse pane, on the Case Home page or the Search page, click the Browse button on the 
toolbar. The first workspace that includes the Browse pane appears, and displays the Browse features 
available to you.

In the Browse pane, you can perform the following tasks:

• Browse for a new document set. To do this, click the name of the item 
that you want to browse for. For example, you can locate the 
documents in a binder, or browse to the documents that contain a 
specific concept.

• Select and filter documents within the current document set that 
meet various criteria. To do this, select the check box next to the 
criteria. For example, you can select all of the documents that are 
coded with a specific quick code value or that are designated with a 
specific issue, and then filter the results set to display only those 
documents.

• Use the Find feature to select documents within a results set based 
on content hits or coding values.

Brow
se pane

Work with the Browse feature

You can customize the sections that appear in 
the Browse pane. For example, you can add 
pick lists as new sections. To do this, click the 
Options button.

The Browse pane also includes additional 
functions for managing concepts, viewing 
and modifying descriptions, and downloading 
concept reports.

Note: Your administrator must enable and configure some features.



The workspace is the arrangement of panes on the Documents page. The workspace appears when you open 
the Documents page after you run a search or browse a document collection. 

About the Workspace feature

W
orkspace

Tip: You can collapse 
or resize any of the 
panes, if you need 
more space. If you 
narrow the width of 
a pane, the pane 
name collapses into 
a menu.

You can perform different tasks in each pane, as follows:
• Use the Browse pane to browse for a new document set, select and filter documents within the current 

results set that meet various criteria, or find document content or coding hits.
• Use the List pane to see information about each document, along with coding and document details.
• Use the View pane to view a document’s text content, native files, and image files.
• Use the Code pane to code documents.
• Use the Conditional Coding pane to code documents.
• Use the Map pane to see an alternate view and visualization of documents that are clustered based on 

the similarity of concepts. 
• Use the Timeline pane to review the distribution of documents over time and how they intersect with 

other information, such as concepts, quick codes, content searches (find), and search term families. 
• Use the Related pane to see a list of documents that are related to each other based on threaded 

relationships, source and attachment relationships, or similarity of concepts.

Note: Your administrator must enable and configure some features.



Customize the workspace

W
orkspace

To add a new workspace or edit an existing workspace, 
open the workspace menu. Then click Add new 
workspace or Edit current workspace.

You can configure a workspace to contain up to five 
panes, including Browse, List, View (A), View (B), Code, 
Conditional Coding, Map, Timeline, and Related.

Multiple workspaces are available by 
default. You can pin up to three workspaces 
to the toolbar. 

Note: If you do not see the default 
workspaces, on the user name menu, under 
User settings, select Reset to Ringtail 
default.

To change the current workspace, click one 
of the three pinned workspace buttons (A, 
B, or C) on the toolbar or click a workspace 
on the workspace menu. 

To pin a different workspace to the toolbar, 
open the workspace menu, and then click 
the pin next to a workspace.

Note: Your administrator must enable and configure some features.



Work with documents in the List pane (standard view) – Overview

When you search for documents, the results typically appear in the List pane on the Documents page. The 
List pane includes information about each document, along with coding and document details.

List pane

Use the List pane to perform the following 
tasks:

• Select documents to view and code
• Select documents for the Working list
• Apply quick codes to documents
• Modify which columns appear in the List 

pane
• Work with threads
• Work with base documents and renditions
• Filter and search the documents in the List 

pane
• Open a document in a linked workspace or 

in a standalone window
• Copy the link to selected documents
• Find similar documents

To download a list of documents, click Download on the List menu.

Note: You can display line numbers in the List pane, which you can set under Search preferences on the user 
name menu or on the Search page.

Note: Your administrator must enable and configure some features.



Configure columns in the List pane

In the List pane, you can sort, add, and delete columns. You can add as many columns as you need. 
You cannot remove or change the position of locked columns in the List pane, although you can hide 
them from display.List pane

Note: Your administrator must enable and configure some features.



Filter columns in the List pane

After performing a search, you can narrow your search results by filtering the columns in the List pane. You can 
filter for text, dates, yes/no values, or numbers.List pane

Text filter

To return to the unfiltered results for the search, click the left arrow button on the left side of the toolbar.

After you apply a filter, the criteria used for the filter become part of the search label. You can then click 
the label to open an advanced search with these criteria on the Search page.

Note: Your administrator must enable and configure some features.



You can edit the values of some fields directly in the List pane. Fields that can be coded directly in the List 
pane appear with an icon in the column heading.

Double-click on a field to edit its value.

List pane

Tip: You can undo changes made to editable fields in the List.

Note: Your administrator must enable and configure some features.

Edit fields inline in the List pane



Work with the email threading feature

Threading-specific elements include the 
following:

• Pivot documents, which contain 
unique content. A thread can have 
one or more pivots.

• Recipient and attachment changes 
within a thread.

Note: You can use the expand all and 
collapse all buttons to view all threads 
or just pivot and root documents.

The email threading feature analyzes document content and organizes email conversations into threads. In 
threaded view in the List pane, you can review documents using both standard and threading-specific 
elements. 

You can use email threading to perform the following tasks:

• Shorten review time by removing duplicate documents and coding only pivot documents.
• Increase review efficiency and accuracy by reviewing threaded documents together.
• View other thread information, such as the thread analysis status, thread ID, thread order ID, and the 

threaded document type.

List pane

Note: Your administrator must enable and configure some features.



Work with the email threading feature

To work with the email threading feature, you can 
perform the following steps:

• Return a set of documents.
• Add documents to thread analysis or remove 

documents from thread analysis by using the 
option on the Tools menu.

• After Ringtail has analyzed the documents and 
created threads, review the threaded documents.

Note: You must select the Threading option on the 
Search preferences menu (on the user name menu 
or on the Search page).

List pane

Note: Your administrator must enable and configure some features.



Review documents in the View pane

View
pane

When you review a document, you determine the document's relevance to a case and identify any 
important content. You review the content of individual documents in the View pane.

The View pane includes different view options to allow you to review a document in the format that is 
most appropriate for the document type, the case strategy, and the overall goals of the review. Because 
you can see different content in each view, it is important to review documents in all views.

Depending on the tasks that you want to accomplish, the type of document you are reviewing, and the 
specific content that you want to review, you can view a document in the following formats:

• Formatted content: Displays the text extracted from a document, with simple formatting applied.
• Unformatted content: Displays the text extracted from a document without any formatting. 
• Native: Displays a document in the native file format of the original application that created the 

document, using the Quick View Plus viewer. 
• Office Online viewer: Displays a native document in Microsoft Office Online directly in the browser.
• Image viewer: Displays image files, PDF documents, and media files.

Note: Your administrator must enable and configure some features.



Review documents in the View pane - Formatted content view

View
pane

Formatted content: Displays the text extracted from a document, with simple formatting applied. 

You can perform the following tasks:
• View keyword hits
• Conduct ad hoc keyword searches
• Search for similar documents based on a selection of text
• View streamlined Bloomberg chats, with interactive color-coding based on participants' organizations

Note: Your administrator must enable and configure some features.



Review documents in the View pane - Unformatted content view

View
pane

Unformatted content: Displays the text extracted from a document without any formatting. 

You can perform the following tasks:
• View keyword hits
• Conduct ad hoc keyword searches
• Search for similar documents based on a selection of text

Note: Your administrator must enable and configure some features.



Review documents in the View pane - Native view

View
pane

Native: Displays a document in the native file format of the original application that created the 
document, using the Quick View Plus viewer. 

You can perform the following tasks:
• Search for content
• Watch video files and listen to audio files

Note: Your administrator must enable and configure some features.



Office Online viewer: Displays native files directly in Ringtail using Microsoft Office Online. You can review 
native files without having to download documents to your computer.

Review documents in the View pane - Office Online viewer

View
pane

Note: Depending on the portal configuration, you may be able to edit documents temporarily, such as adding 
temporary highlights. Ringtail does not save any edits that you make in the Office Online viewer.

* The availability of features marked with an asterisk (*) depends on your organization's license with Microsoft and the 
portal options that are configured by your administrator.

You can perform the following tasks:
• Search for content
• See formulas*, resize columns, 

and display hidden worksheets, 
rows, and columns* in a 
Microsoft Excel spreadsheet

• View comments in Microsoft 
Word*, Microsoft Excel, and 
Microsoft PowerPoint

• View slide notes*, slide 
thumbnails*, and hidden slides* 
in a Microsoft PowerPoint 
presentation

• Use standard Microsoft Office 
features to review content*

• View native files that were 
created in applications other 
than Microsoft Office

• Watch video files and listen to 
audio files

• Display hidden content

Note: Your administrator must enable and configure some features.



Review documents in the View pane - Image viewer

View
pane

Image viewer: Displays image files, PDF documents, 
and media files.

You can perform the following tasks:
• View imaged document pages
• Add annotations such as highlights or redactions
• Search for text to highlight or redact in searchable 

PDFs
• Convert highlights to redactions, and convert 

redactions to highlights
• Add notes to specific document pages
• Print a document
• Watch video files and listen to audio files
• View comprehensive Bloomberg chats, including 

event logs and noise content

Note: Your administrator must enable and configure some features.



The following table describes the features in the View pane.

View pane features (1 of 2)

View
pane

Element Purpose

Formatted content Displays the text extracted from a document, with simple formatting applied.

Unformatted content Displays the text extracted from a document without any formatting.

Native Displays a document in the native file format of the original application that created the 
document, using the Quick View Plus viewer.

Office Online viewer Displays native files in Microsoft Office Online directly in the browser.

Image viewer Displays image files, PDF documents, and media files. 

Document type Indicates the document type. If quick coding is enabled, click the document type button to 
apply a quick code to a document.

Source/Attachment family A colored line next to the document type button indicates that the document is part of a 
document family. A document family contains a group of documents made up of a source 
document and its attachments. The color of the line indicates the quick code value that has the 
highest family rank within that document family.

Document ID The ID number of the document that appears in the View pane. The document ID is a unique 
number that is associated with each document in the database.

The document that appears in the View pane is also called the active document.

Note: Your administrator must enable and configure some features.



View pane features (2 of 2)

View
pane

Element Purpose

Hidden content warning Indicates that a native file includes hidden content, such as tracked changes, speaker notes in a 
presentation, or hidden columns in a spreadsheet. Hover over the warning icon to determine 
the type of hidden content that the document contains.

Truncated content warning Indicates that a document is larger than the maximum file size set by your administrator. To see 
the whole document, switch to a different view or download the document.

Keyword hit navigation Displays the number of keyword hits in the document. To navigate between keyword highlights 
in the document, click the Next hit or Previous hit buttons.
Note: If the document is larger than the maximum file size set by your administrator, only the number of 
visible keyword hits appears.

Keyword highlights Displays keyword highlights and allows you to conduct ad hoc content searches.

Find and redact Allows you to find text in a searchable PDF document, and then add highlights or redactions to 
the text.

Show hidden content Displays hidden content in Microsoft Excel, Word, and PowerPoint documents.

Download Downloads a document in its original file format.

Update pages Allows you to add or remove pages in a document, if you have permission to do so.

Collapse Collapses the View pane.

View menu and options The View menu includes options for working with documents in the View pane.
Note: You can pin any of these buttons to the View pane toolbar.

Note: Your administrator must enable and configure some features.



Coding a document is the process of marking a document with the information that you identify during a 
review. Documents that are coded as responsive can then be produced and provided to a third party in 
response to a discovery request.

Depending on your case, you can code documents in the Code pane or the Conditional Coding pane. 

Code documents

Code
docum

ents

In the Code pane, you can perform the following 
coding tasks:

• View the existing coding values for a document, 
locate documents that are coded with the same 
values, or configure the layout of the Code pane. 

• Quickly code a document by selecting a color-
coded value from a list (called a quick code).

• Apply suggested coding values to a document 
using hints. 

• Add or update values in individual coding fields. 
• Code documents to issues.
• Code documents to binders.
• Code documents to people or organizations.
• Link a document to related objects, such as other 

documents, shared binders, issues, levels, saved 
searches, transcripts, or websites.

Note: Your administrator must enable and configure some features.



Code documents in the Code pane

• To save field edits, press Tab or 
Enter.

• To delete field edits, click the 
field value, and then press 
Delete.

• Multivalue fields display a plus 
sign and allow you to code 
multiple values.

• When coding pick list fields with 
many values, type a few letters 
to narrow the list of values.

Tip: To apply values from 
the previously displayed 
document, select a 
coding template on the 
All Values menu, and 
then use coding hints.

To edit a field, click in any 
field with a blue triangle 
and change its value. 

To apply issue coding, on 
the All Values menu, 
select Issues, and then 
select one or more check 
boxes. 

To apply a quick code, click 
the blue dot. 

To search for documents that 
have the same coding, click 
the magnifying glass. 

Code pane

Note: Your administrator must enable and configure some features.



When you code documents in the Conditional Coding pane, you can quickly determine which fields, 
binders, and issues you should code depending on the values that you provide for related fields. After you 
code each object, the colors of the remaining objects change to indicate which items you still need to code.

Code documents in the Conditional Coding pane

ConditionalCoding
pane

Objects that you have already coded appear in 
green, objects that your administrator does not 
expect you to code appear in gray, and objects 
that must still be coded appear in white.

If you code a value that is unexpected based on 
the other values that you have coded, the object 
appears in yellow and a warning message 
appears.

Note: To access this feature, add a Conditional Coding 
pane to your workspace.

Tip: You can use coding macros to code a document 
to a predefined set of values by clicking a single 
button. To create a new coding macro, click the plus 
(+) button.

Note: Your administrator must enable and configure some features.



Work with the Map

You can perform the following tasks with the Map:
• Review documents based on their concepts.
• Explore concepts that tend to appear together in selected documents.
• Find documents that share common concepts.
• Apply quick codes to one or more documents directly in the Map.
• Find documents that have the same quick code or the same family quick code.
• Select multiple documents for a bulk action, such as coding or adding documents to a binder.
• Search the Map for keywords to locate clusters and documents with those terms.
• Select a document to preview in the View pane or in a standalone workspace.
• Discover new concepts in the documents.

The Map pane is an alternate view of 
documents in an assignment or a search results 
set in which documents are clustered based on 
the similarity of concepts. 

You can navigate from document to document, 
view relationships between documents, search 
documents, and code documents while viewing 
the Map. 

You can display up to 10,000 documents per 
page.

M
ap pane

Note: Your administrator must enable and configure some features.



Map elements
The Map pane contains the following elements:

• Concept cluster: A group of documents in a spiral arrangement in a circle. The circle may appear solid 
when you first open the Map, indicating that all the documents in the cluster have the same quick code 
value. You can configure the Map to always display individual document dots.

• Cluster tooltip: A tooltip that appears when you hover over a cluster. The tooltip displays the concept 
shared by clusters displayed on the spine. When spines intersect, multiple concepts display at the top of 
the tooltip. The tooltip displays the top concept, the next highest six concepts, the number of documents 
in the cluster, the percent of documents coded, and the top document titles in the cluster. You can 
configure the Map to position the tooltip in the corner of the pane.

• Concept compass: The ring that surrounds concept clusters. Clusters can appear inside or outside the 
ring depending on the cluster configurations. 

• Map menu: The menu associated with the Map pane that lists options for using and configuring the 
Map. You can pin the options on the menu to the Map toolbar for easy access.

• Page navigation window: A small window on the side of the Map that appears when the Map includes 
more documents than can be displayed on one page. Use the navigation controls to move through 
documents on additional pages of the Map. You can configure the number of documents to view per 
page on the Map pane’s Options menu.

• Set-aside clusters: Square containers, or clusters, in the lower right for storing coded documents. The 
color indicates the quick code value. Use the Quick Codes section in the Browse pane to move 
documents between the Map and the set-aside clusters. 

• Spine: A line that connects clusters that have one or more significant concepts in common. Along a 
spine, documents in adjacent clusters are more similar to each other than to documents in clusters that 
are farther away.

• Spine label: The concept that clusters in a spine have in common. The spine label appears around the 
concept compass. Spine labels can provide a quick overview of the key concepts in an area of the Map.

• Triangle: Indicates the active document.
• Zoom slider: A vertical control on the right side of the Map that allows you to zoom in and out of 

clusters.

M
ap pane

Note: Your administrator must enable and configure some features.



Customize the Map

Although the default display in the Map is sufficient for most review work, you may want to modify what you 
see in the Map. Options for configuring the Map appear on the Options menu, which you can access 
through the Map menu.

• Spines: Shows or hides the spines that join concept clusters.
• Compass: Shows or hides the compass ring.
• Labels: Shows or hides the concept labels that appear around the compass ring.

• Pointers: Shows or hides the lines that connect related concept clusters 
to the concept labels.

• Show tooltip: When you hover over a cluster, displays a tooltip that provides 
information about the documents in the cluster.

• Pin tooltip: Displays the cluster tooltip in a corner of the Map so that it 
does not cover up the Map.

• Set-aside on family code: Automatically places all of the documents in a 
document family in the set-aside cluster that matches the documents' family 
code (the highest-ranking quick code value for the family). When this option is 
cleared, each document is placed in the set-aside cluster that matches the 
document’s individual quick code.

• Solid for uniform coding: If all of the documents in a cluster have the same 
quick code, the concept cluster appears as a solid color. If documents within the 
cluster have different quick codes, the cluster shows individual colored dots. 
When you zoom out, the cluster appears as a pie chart, which represents mixed 
coding in a cluster.

• Working list: Displays the Working list view in the List pane.
• Page size: Sets the number of documents to display on each page. The default 

is 2,500, although you can display up to 10,000 documents per page.

M
ap pane

Tip: On the Tools menu, you can select a color theme for the Map and the Timeline.

Note: Your administrator must enable and configure some features.



Work with the Timeline 

In the Timeline pane, you can review the distribution of documents over time and determine how they 
intersect with other information, such as concepts, quick codes, content searches (find), and search term 
families.

Tim
eline pane

You can perform the following tasks with the Timeline:

• Select documents in a time range, a specific time interval, or a selection of specific time intervals.
• As a reviewer, select a different Timeline date field to use during a review. The time field used to configure 

the Timeline is set at the case, group, and user level.

You can use the Timeline feature with result sets up to 50,000 documents.

Tip: On the Tools menu, you can select a color theme for the Map and the Timeline.

Note: Your administrator must enable and configure some features.



Work with the Related pane

In the Related pane, you can review documents that are related to each other based on threaded 
relationships, source and attachment relationships, or similarity of concepts.Related pane

You can perform the following tasks in the 
Related pane:
• Change the active document within a 

document family
• See the coding for related documents
• Apply quick codes to documents
• Maximize a section, or collapse or expand 

sections

The Related pane includes the following 
sections:
• Sources and attachments: Displays the 

active document and any documents 
with a source or attachment relationship 
to the active document.

• Threading: Displays the active 
document and a list of documents with 
a threaded relationship to the active 
document.

• Similar: Displays the active document 
and a list of documents that share at 
least 70% of the same concepts. The 
number in the Similarity column 
indicates the fraction of concepts that 
the documents share in common.

Note: Your administrator must enable and configure some features.



Work with Tools on the Documents page

The Tools menu on the Documents page includes a 
variety of features for working with documents. You can 
pin the options on the Tools menu to the toolbar.

The new Imaging tool allows you to convert 
documents to images, and the Reverse previous 
imaging tool allows you to reverse the imaging 
process. The Imaging tool replaces the TIFF-on-the-Fly 
feature.

Tools

Note: Your administrator must enable and configure some features.



Print documents to PDF

You can print documents to PDF using the 
Batch Print tool, which is located on the 
Tools menu. After you print documents to 
PDF, you can use the print options in your 
PDF viewer to print hard copies.

You can print documents that contain 
image files or PDF files. You can specify 
whether to include highlights, redactions, 
and footers.

You can print each document separately 
or combine multiple documents into one 
PDF file.

Batch print

Note: Your administrator must enable and configure some features.



Review Bloomberg chat documents
You can review chat documents from Instant Bloomberg chats and persistent chat rooms. Chats are also 
called instant messages.

Bloom
berg chat

A chat includes a variety of information. In addition to the messages that participants send to each other, a 
chat can include the following information:
• Content that participants send to each other, such as messages, attachments, and invitations to ask other 

people to join the chat.
• Event logs that provide information about participants' actions, such as when a person entered and exited 

a chat, or whether a person viewed the chat history to learn what happened in a chat room before they 
entered.

• Noise content that is distracting or irrelevant to the review, such as automatic disclaimers that are posted 
when people enter a chat.

• Metadata, such as the date and time of the chat, the names of participants, and the number of messages in 
the conversation. You can search for chat metadata and use it to focus the review. The metadata for a chat 
document appears in the Code pane.

Tip: To search for chat documents, create a 
search that includes the Document Type field 
with a value of Bloomberg Instant or 
Bloomberg Persistent. 

Note: Your administrator must enable and configure some features.



Review Bloomberg chat documents

Depending on your review strategy, you can review chat documents in the View pane using the following 
views:

• Lite chat: Quickly review only the content that participants sent to each other. Lite view displays a subset 
of chat information: messages, attachments, and invitations. The chat is color-coded based on 
participants' organizations. You can identify content that was sent by specific people or organizations by 
toggling participant names, organizations, or actions in the summary table. You can also display or hide 
keyword highlights.

• Full chat: Review all of the information in a chat, including content that participants sent to each other, 
event logs, and noise content. You can use event logs to determine the full context of a chat. For 
example, you can identify whether an individual participated in a chat when something important was 
said, even if they only viewed the content and did not send a response. As another example, you can 
analyze an individual's view history to determine when they learned about particular information.

Both chat views include a summary table that displays the organization names, participant names, and the 
number of messages (MSG), attachments (ATC), and invitations (INV) that were sent by each participant.

Tip: People frequently use informal language, abbreviations, and jargon in chats, and typos may be common. 
Because of this, you should adjust your search and review strategy to make sure that you do not miss any 
important information. If you use keyword highlights to identify important content, your administrator or 
review lead should make sure that any search term families include all relevant phrases.

If the chat file includes attachments, the attachments are attached to the chat document in Ringtail. 

To add annotations to a chat document, such as redactions, you can create an image file of the chat 
document, and then annotate the image file.

Bloom
berg chat

Note: Your administrator must enable and configure some features.



Review transcripts

You can review transcripts on the Transcripts page.

To access the Transcripts page, on the Case Home menu, click Transcripts.

Transcripts

All users can do the following:
• Search and filter transcripts 

based on content, annotations, 
or transcript type

• Annotate transcripts with 
highlights (transcript issues) and 
notes

• Link transcripts to other objects 
in a case, such as related 
transcripts

• Create a report of the 
annotations in one or more 
transcripts

• Export transcripts to Microsoft 
Word

Group leaders can do the following:
• Upload transcripts to a case
• Download transcripts as portable 

case format (PCF) files, to share 
with users outside of Ringtail

• Administer transcripts

Note: Your administrator must enable and configure some features.



Work with assignments

You can access your assignments from the Case Home page by clicking My Assignments in the navigation 
pane. Or, click the My Assignments link on the Case Site Map.

Assignm
ents

Assignment completed

On the My Assignments page, you can get your assignments, clear completed assignments, and suspend or 
unsuspend assignments. Group leaders can also revoke assignments.

After you access your assignments on the My Assignments page, Ringtail displays the documents that 
require coding or review. Where the documents appear depends on your workspace configuration. The 
documents typically appear in the List pane.

If an assignment meets the 
coding requirements, the 
assignment is automatically 
cleared.

Assigned documents in the List pane

Note: Your administrator must enable and configure some features.



Review Dashboard
You can view the progress of an active review using the Review Dashboard. The Review Dashboard includes 
a progress bar, graph, and reviewer matrix that display the review status of all documents in the case. The 
information in the Review Dashboard is pre-populated to show all documents in the case. If you select a 
different document set, coding field, or team, the dashboard updates accordingly. 

To access the Review Dashboard, on the Case Home page, click the Review Dashboard link in the 
navigation pane. Or, click the Review Dashboard link under Analysis.

Note: This feature is available to case administrators by default. Administrators can enable this feature for group leaders and 
group members on the Security > Administration page.

Review
 D

ashboard

Note: Your administrator must enable and configure some features.



Review Dashboard
The Review Dashboard includes the following information and options:

• Document set: The default option is All documents in the case. You can select a type of document set in 
the list, such as a binder. After you select a type, a second list appears. Depending on the type, select a 
specific document set from the list, or click the arrow and then select a specific document set. The progress 
bar, chart, and reviewer matrix update to show information for the newly selected set of documents.

• Coding field: This list prepopulates with a quick code field. You can change this field to any quick code field 
currently available in the case. When you select a different quick code field from the list, the Review 
Dashboard updates accordingly.

• Progress bar: Indicates the percentage of documents that are coded.
• Estimated completion: Indicates the estimated number of working days that are required to code the 

remaining uncoded documents, based on a rolling average review rate over the past seven days, excluding 
weekends.

• Average documents coded per reviewer: Indicates the rolling average of documents that are coded per 
reviewer per day, excluding weekends.

• Doughnut chart: Displays the number of documents and percentages of coded values for the selected 
coding field.

• Team list: Allows you to see the review status for different teams. The default option is All teams. When you 
select a different team, the information in the reviewer matrix updates, but the rest of the information in the 
Review Dashboard remains unchanged.
Note: The available teams depend on each team’s security settings in the Review Setup section. Users with 
permission to administer teams can choose from any team. Users without permission to administer teams can choose 
from the teams that they are members of.

• Reviewer matrix: This table, located at the bottom of the page, displays coding metrics for individual 
reviewers, such as the average number of documents coded per day. A bar chart for each reviewer shows the 
percentages and number of documents that the reviewer coded for each quick code value. Hover over a bar 
to see the details. You can sort the columns in the Documents coded area.

Tip: To export information in the reviewer matrix to a spreadsheet (.csv file), click the Download button on the 
toolbar.

Review
 D

ashboard

Note: Your administrator must enable and configure some features.



Work with Search Terms

You can view statistics for search term hits in documents using the Search Terms reporting feature.

To access the Search Terms page, on the Case Home page, click the Search Terms link under Analysis.

• In the Counts section, you can view information about search term hits across document sets. You can 
also view how each search term contributes to the overall population of hits at a document and family 
level.

• In the Coding section, you can review how many documents containing a particular term were coded with 
specific values. This allows you to evaluate search term effectiveness using recall and precision values. 

Search Term
s

You can download the full report as a spreadsheet (.csv file).

Note: An administrator can make this feature available to group leaders or group members on the Security > Administration 
page.

Note: Your administrator must enable and configure some features.
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